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Visuals Overview 

Visuals allow the user to view and analyze data. Once the Visuals are created, they can be shared via an 

external link individually or as part of a dashboard. 

Types of Visuals 

There are several different options for visuals depending on how users want to display their data. The 

different types of visuals are outlined below. 

• Area and Area Spline Charts display data points connected by straight lines with color filled in the 

area underneath each line. 

• Bar Charts display horizontal bars to show categorical data, using the length of each bar to show 

values. 

• Column Charts are like Bar Charts but use vertical bars to represent each value. 

• Line Charts display data points connected by straight lines. 

• Pie Charts are circles divided into slices that show values using the size of each slice. 

• Scatter Plots show individual data points. 

• Spline Charts are line charts that use curved lines between data points, giving a more natural 

approximation of interpolated values. 

• Trend Charts show how data changes over time. Users can make Trend Charts using Line, Spline, 

Area, Area Spline, Bar, and Column Charts. 

• Heatmaps are graphical representations of data where the individual values contained in a matrix 

are represented as colors. 

• Spider Charts are two-dimensional representation of multivariate data on axes starting from the 

same point. It is a circular graph used as a comparative tool. 

• Big Number displays a single number standing for a user-defined value, such as an aggregate value 

of a given Field. 

• Gauges like Big Numbers but display a gauge indicating what percentage the value shown makes up 

of a total value. 

• Maps display data from a result set associated with a location and overlay that data onto a map. 

• Google Maps show aggregate data based on location using heat markers. 

• Data Grids display information in a row and column format. 

• Pivot Tables summarize data by organizing information into related groups, based on sums, 

averages, or other statistics. 
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• Summary Tables show aggregate data based on groups. 

• HTML displays a static visual and/or text with HTML code. 

There are several different ways to create Visuals. The user can create them via Discover, adding Visuals 

Manually or creating Visuals when inside the Dashboard. There are different configuration options for each 

Visual. 

 

Pivot and Summary Tables 

What is a Pivot Table? 

Pivot Tables are one of the Visual options for Datasets, Dashboard Reports, and Comparison Board Reports. 

This supplies a way to summarize a more extensive data table by organizing the information into related 

groups based on sums, averages, or other statistics. Often there will be footer rows or summary rows that 

give breakdowns of an entire group's aggregate statistics. 

 

 

 

Pivot Tables can be exported out from Informer 5 and saved as a static CSV or PDF files. Users can also drill 

down into an individual cell's data by clicking on it to open a new Data Grid panel, which only display the 

drilled down data. This subset of information can also be exported out of the system. Clicking a cell in the 
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table will open a Data Grid of the records pertaining to the selected cell. This Data Grid can be exported by 

clicking the 'Export' icon in the top-right corner. 

 

 

Creating a Pivot Table 

To create a Pivot Table, go to the Dataset Listing Page and open the Dataset containing the data to use and 

click the Pivot icon in the left panel. 

 

This will open a screen containing a Pivot Table and options at the top for setting Rows, Columns, and 

Values, as well as a 'Start Over' button that clears all selections. 
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• Rows - displays a drop down containing all the fields in the result set. Checking a box will re-render 

the pivot table and add row groupings for all the unique values in the field whose box was checked. 

If more than one field is selected for the rows, the field groupings will be nested inside each other in 

the order they were selected. 

• Columns – displays a drop down containing all the fields in the result set. Checking a box will re-

render the pivot table and add column groupings for all the unique values in the field whose box 

was checked. If more than one field is selected for the columns, the field groupings will also be 

nested inside each other in the order they were selected. 

• Values – displays a drop down containing all the fields in the result set. Checking a box will re-

render the pivot table and change the values in each cell to be the selected field aggregation. If more 

than one field is selected for the display values, each aggregation will get its own sub-column. There 

are different options depending on the data type 

Pivot Table Settings 

In addition to having full control over which rows, columns, and values get displayed in the pivot table, there 

are also different display options that can be adjusted so that the data gets presented customized to the 

user’s preference.  

 

To access the pivot table settings, click the ‘configure’ gear icon in the top-right of the pivot table window. A 

settings panel will pop up with configurable options for the pivot table layout, ordering, limits, column-by-

column formatting, as well as a preview panel. 
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• Layout - this section allows the user to change how any nested groupings for rows are displayed 

inside of the pivot table.  There is also the option to add in more row or column pivots. 

• Order - this section allows users to change the ordering of the columns based on their values.  

Choose from values ascending or descending, or alphabetically by group header ascending or 

descending. 

• Drilldown - this section allows users to enable or disable the ability to drill down into a specific cell's 

data by clicking on that cell. This option is helpful by giving end users a "big picture" view of the data, 

rather than the raw data itself. 

• Values - each value or aggregate in the pivot can be assigned a custom header, formatting, and 

conditional coloring based on its value. 

o Value – allows user to change the aggregate type and header for an already-added value. 

o Number Formatting – allows user to customize how the numeric values appear in the Pivot 

Table. 

o Color Ranges – allows users to set up conditional color formatting for the aggregate 

columns, depending on their value. 

• Performance – when a pivot table is built from millions of records with unique grouping values, 

users can limit how many of these unique groupings are included in the pivot table. 

Editing an Existing Pivot Table 

To edit a Pivot Table that has been saved to the Visuals of a Dataset, open the Dataset with the Pivot Table 

to change and click the Visuals icon in the panel to the left to open the Visuals screen. 
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Double-click the Pivot Table to edit. This will open a window to configure the Visual. 

 

Once finished, click 'Apply' at the bottom-right corner of the configure screen to save changes. 

Visuals 

Creating a Visual 

To create a visual from scratch without using the Discover feature, go into the ‘Visuals’ section on the 

Dataset. 

 

 

 



entrinsik.com/informer  Page 12 

If there are already Visuals associated with the Dataset, a list will display and a 'New Visual' button in the 

top-left of the UI (user interface).  

 

 

Otherwise, the only choice will be to create a new visual. 

 

 

 

Clicking 'New Visual' will present the user with several types of visuals. 
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Configuring Visuals 

Bar and Column Charts 

To configure a Bar or Column Chart, open the Report containing the chart and click the ‘…’ icon in the top-

right corner of the Visual. Select ‘Configure’ to open the Configure Visual window. To configure a Chart that 

has been saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click on 

the Chart. The left panel is made up of five categories of settings users can use to customize their Visuals: 

Settings, Series, Y-Axis, Legend, and Drilldown. 
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Settings 

 

• Group by - Select a Field to use for the x-axis of the chart 

• Sort groups by - Choose how groups are sorted along the x-axis 

• Number of groups to show - Maximum number of individual groups that should be shown in the 

chart. The default is 10 

• Include other/remaining items - Changes whether a separate group is generated for records not 

in the shown groups 

• Include empty/null items - Changes whether groups with empty or null items are shown in the 

chart 

• Split by field - Choose which Field to split groups by  

• Number of sub-groups to show - Maximum number of sub-groups to split each group into 

• Zoom - Allows the user to zoom on the x-axis, y-axis, or both 

• Stacking - Changes how sub-groups are stacked  

o None - No stacking, good for comparing values within a single group 

o Normal - Stacks groups on top of each other, showing the total of split by groups separated 

by color 

o Percent - Shows what percentage each sub-group makes up of their corresponding groups 

• X-Axis title - Provides a label for the x-axis 
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Series 

 

• Series Tabs - Lists the series in the Visual to edit 

• Add aggregate - Adds a new series to the chart 

At the bottom of the Series panel are four icons - Series, Color, Label, and Delete. Delete removes the 

current series from the chart, while the others show different settings for the series. 

Series 

• Value - Allows users to select which type of value to show with the series  

o Per-group - Calculates aggregate values for each group 

o Overall - Calculates aggregate values for the entire Dataset 

o Literal - Adds a horizontal line at a given value to the chart 

• Value Field - Sets the type of aggregate value to calculate for the series 

• Missing Values – Only applies to line, area, spline and area spline chart types 

• Series name - Changes the name of the series in the legend 

• Series chart type - Changes the type of chart being used 

• Y-Axis - Allows users to choose which y-axis to use for the series or add a new one. Y-axes can be 

customized in the Y-Axis panel 

https://informer5.zendesk.com/hc/en-us/articles/360001193883#223
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Color 

• Series color – Changes how the color of each series is chosen 

Labels 

• Show labels in-line - Adds labels to the data points in the chart 

• Label content - Choose whether to show the group label, value, and/or percent of each group 

• Decimal Places - How many digits after the decimal to show 

• Tooltip - Changes how information is displayed when the user hovers the mouse over a group in the 

chart  

Y-Axis 

 

 

• Y-axes - Shows a list of y-axes that have been added. Click the down arrow to the left to change 

settings for individual axes 

• Add Axis - Adds a new y-axis to the Visual 

 

 



entrinsik.com/informer  Page 17 

Legend 

 

• Show legend - Toggles whether to show a legend on the Visual 

• Float legend over chart - If enabled, places the legend on top of the chart instead of resizing the 

chart to make room for it 

• Vertical Align - Moves the legend to the top, middle, or bottom of the chart 

• Horizontal Align - Moves the legend to the left, center, or right side of the chart 

• Maximum Height - Specifies the maximum height in pixels of the legend 

Drilldown 

 

• Enable view data - Enables the 'View data' and 'Pivot by' options to show a data grid or pivot table 

when the user clicks a group in the Visual 
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• Enable chart drilldown - Enables the 'Drilldown by' option to split data by a given Field when the 

user clicks a group in the Visual 

 

Heat Maps 

To configure a Heat Map, open the Report containing the chart and click the "…" icon in the top-

right corner of the Visual. Select "Configure" to open the Configure Visual window.  To configure a Heat Map 

that has been saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click 

on the Heath Map. The left panel is made up of four categories of settings to customize their Visuals: 

Settings, Color, Legend, and Drilldown. 
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Settings 

 

 

 

• X-Axis - Select a Field to use for the x-axis of the chart  

• Sort groups by - Choose how groups are sorted along the x-axis  

o Value - Sorts by the value of the aggregate from largest to smallest 

o Group Ascending - Alphabetical order by group column name 

o Group Descending - Alphabetical order by group column name 

• Y-Axis - Select a Field to use for the y-axis of the chart 

• Numeric Field - Choose the numeric field and the aggregate to display in the boxes 

• Labels- Choose the Tooltip for hovering over the boxes in the Heat Map (Title, Prefix, Suffix and Decimal 

Places) 
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Color 

 

• Minimum Color – choose the color to indicate lower value data points 

• Maximum Color – choose the color to indicate higher value data points 

Legend 

 

• Show legend - Check to show legend 

• Float legend over chart - If enabled, places the legend on top of the chart instead of resizing the chart 

to make room for it 

• Vertical Align - Moves the legend to the top, middle, or bottom of the chart 

• Horizontal Align - Moves the legend to the left, center, or right side of the chart 

• Max Height - Specifies the maximum height in pixels of the legend 
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Drilldown 

 

 

 

• Enable view data - Enables the 'View data' and 'Pivot by' options to drill into data or create pivot 

tables based on columns in the Dataset 

• Enable chart drill-down Enables the 'Drilldown by' option to split data by a given Field in a 

Dataset.  This option can limit the drill-down Fields available from a specific visual. 

• All Fields – allows drilling down to all fields in the Dataset 

• Selected Fields – choose which fields to drill down into (Example above allows only drilling down into 

Employees First Name, Employees Last Name and Customer) 

Pie Charts 

To configure a Pie Chart, open the Report containing the chart and click the '...' icon in the top-right corner 

of the Visual. Select 'Configure' to open the Configure Visual window.  To configure a Pie Chart that has been 

saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click on the Pie 

Chart. The left panel has five options with several settings users can use to customize their Visuals: Settings, 

Series, Y-Axis, Legend, and Drilldown. 
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Settings 

 

• Group by - Select a Field to use for the x-axis of the chart 

• Sort groups by - Choose how groups are sorted along the x-axis 

• Number of groups to show - Maximum number of individual groups that should be shown in the 

chart 

• Include other/remaining items - Changes whether a separate group is generated for records not 

in the shown groups 
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• Include empty/null items - Changes whether groups with empty or null items are shown in the 

chart 

• Split by field - Choose which Field to split groups by if the user changes the chart to a bar or column 

chart  

• Number of sub-groups to show - Maximum number of sub-groups to split each group into 

• Zoom - Allows the user to zoom on the x-axis, y-axis, or both 

• Stacking - Changes how sub-groups are stacked if the user changes the chart to a bar or column 

chart  

o None - No stacking, good for comparing values within a single group 

o Normal - Stacks groups on top of each other, showing the total of split by groups separated 

by color 

o Percent - Shows what percentage each sub-group makes up of their corresponding groups 

• X-Axis title - Supplies a label for the x-axis  

Series 

 

 

• Series Tabs - Lists the series that are part of the Visual 

At the bottom of the Series panel are four icons - Series, Color, Label, and Delete. Delete removes the 

current series from the chart, while the others show different settings for the series. 
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Series 

• Value Type – Allows users to select which type of value to show with the series  

o Per-group - Calculates aggregate values for each group 

o Overall - Calculates aggregate values for the entire Dataset 

o Literal - Adds a horizontal line at a given value to the chart 

• Value - Sets the type of aggregate value to calculate for the series 

• Series name - Changes the name of the series in the legend 

• Series chart type - Changes the type of chart being used 

• Y-Axis - Allows users to choose which y-axis to use for the series or add a new one. Y-axes can be 

customized in the Y-Axis panel  

Color 

• Series color - Changes how the color of each series is chosen  

Labels 

• Show labels in-line - Adds labels to the data points in the chart 

• Label content - Choose whether to show the group label, value, and/or percent of each group 

• Decimal Places - How many digits after the decimal to show 

• Tooltip - Changes how information is displayed when the user hovers the mouse over a group in the 

chart  

Y-Axis 

• Y-axes – Setting is not available in a Pie Visual 
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Legend 

 

• Show legend - Toggles whether to show a legend on the Visual 

• Float legend over chart - If enabled, places the legend on top of the chart instead of resizing the 

chart to make room for it 

• Vertical Align - Moves the legend to the top, middle, or bottom of the chart 

• Horizontal Align - Moves the legend to the left, center, or right side of the chart 

• Max Height - Specifies the maximum height in pixels of the legend  

Drilldown 

 

• Enable view data - Enables the 'View data' and 'Pivot by' options to show a data grid or pivot table 

when the user clicks a group in the Visual 

• Enable chart drilldown - Enables the 'Drilldown by' option to split data by a given Field when the 

user clicks a group in the Visual 
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Scatter Plots 

To configure a Scatter Plot, open the Report containing the chart and click the '...' icon in the top-right corner 

of the Visual. Select 'Configure' to open the Configure Visual window. To configure a Scatter Plot that has 

been saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click on the 

Scatter Plot. The left panel has three options with several settings to use to customize Visuals: Settings, 

Color, and Legend. 

 

 

 

Settings 
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• X-Axis - Select a Field to use for the x-axis of the chart 

• Y-Axis - Select a Field to use for the y-axis of the chart 

• Number of items to show - Maximum number of individual data points that should be shown in the 

chart 

• Point Label - Choose which column value to display when hovering over a point in the graph 

• Show regression line - Generates a regression line using the data in the chart 

Color 

 

 

• Point color – changes the color of the points in the chart 

• Line color – changes the color of the regression line if one has been added 

Legend 
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• Show legend – toggles whether to show a legend on the Visual 

• Float legend over chart – if enabled, places the legend on top of the chart instead of resizing the 

chart to make room for it 

• Vertical Align – moves the legend to the top, middle, or bottom of the chart 

• Horizontal Align – moves the legend to the left, center, or right side of the chart 

• Max height – specifies the maximum height in pixels of the legend 

Spider Charts 

To configure a Spider, open the Report containing the chart and click the "…" icon in the top-right corner of 

the Visual. Select "Configure" to open the Configure Visual window. To configure a Spider Chart that has 

been saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click on the 

Spider Chart. The left panel is made up of five categories of settings to customize their Visuals: Settings, 

Series, Y-Axis, Legend, and Drilldown. 
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Settings 

 

• Group by – select Field to use for the x-axis of the chart 

• Sort groups by – Choose how to sort groups along the x-axis 

o Value – sorts by the value of the aggregate from largest to smallest 

o Group Ascending – alphabetical order by group column name 

o Group Descending – alphabetical order by group column name 

• Number of groups to show – maximum number of individual groups to show in the chart 

• Step – display labels by either allowing all labels or to step over by increments 

• Label Rotation – this sets the degree of angle on the x-axis group labels 

• Include other/remaining items – Creates a separate group for records not displayed (if the 

number of groups to show is 10, and there are more than 10, this will display the remaining data) 

• Include empty/null items – creates a separate group for empty or null values 

• Split by field – choose the Field to split groups to visually display a second group inside the chart 

• Number of sub-groups to show – maximum number of sub-groups to split each group into 

• Zoom – set the zoom on the x-axis, y-axis, or both 

• Stacking – changes the display of the Group By and Split By features 

o None – no stacking, good for comparing values within a single group 

o Normal – stacks groups on top of each other, showing the total of split by groups separated 

by color 

o Percent – shows what percentage each sub-group makes up of their corresponding groups 
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Series 

There are four icons at the bottom of the Series panel: Series, Color, Label, and Delete. Delete removes the 

current series from the chart, while the others show different settings for the series. 

 

 

 

• Add aggregate - Adds a new series to the chart ("+ "sign next to Series 1) 

• Value Type – Select which type of value to show with the series    

o Per-group - Calculates aggregate values for each group  

o Overall - Calculates aggregate values for the entire Dataset  

o Literal - Adds a horizontal line at a given value to the chart  

• Value Field - Sets the type of aggregate value to calculate for the series 

• Missing Values - Use this setting to skip null or zero values in groupings when viewing the chart.  It 

allows for a continuous line if the aggregate of the group is zero or null 

• Series name - Changes the name of the series in the legend  

• Series chart type - Changes the type of chart being used  

• Y-Axis - Name the Axis - more than one Axis on a Spider Chart does not make sense 
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Color 

 

• Auto - Informer chooses best color strategy based on scenario 

• Based on Value - tries to match colors associated with other charts and the same values 

• Rotate - rotates series color so that it compliments adjacent colors 

• Shades - choose the color and it displays various shades of that color 

• Exact - choose an exact color for a value 

Data Labels 

 

 

• Show labels in-line - Adds labels to the data points in the chart  

• Label content - Choose whether to show the group label, value, and/or percent of each group  

• Decimal Places - How many digits after the decimal to show  

• Tooltip - Formats information about a specific point in a chart when hovering over a group in the 

chart 
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Y-Axis 

The Spider Chart only needs one Y axis. 

 

 

 

• Y-Axis - shows a list of y-axes added to the Visual. Click the down arrow to the left to change settings 

for an individual axis 

• Add Axis - Add Axis to chart.  These types of charts would only use one Axis 

• Axis Title - Adds Title to Visual 

• Type - Choose which type of axis to use: Linear, Logarithmic, Datetime or Category 

• Min/Max - Designates a min and max for an axis.  This helps to focus the view of the data on the 

Visual. (See Visual above is set to Min: 20 and Max: 100) 

• Show on Right Side - Not relevant as there would not be a second axis 
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Legend 

 

• Show legend - Check to show legend 

• Float legend over chart - If enabled, places the legend on top of the chart instead of resizing the 

chart to make room for it 

• Vertical Align - Moves the legend to the top, middle, or bottom of the chart 

• Horizontal Align - Moves the legend to the left, center, or right side of the chart 

• Max height - Specifies the maximum height in pixels of the legend 

Drilldown 

 

• Enable view data - Enables the "View data" and 'Pivot by' options to drill into data or create pivot 

tables based on columns in the Dataset 

• Enable chart drill-down - Enables the "Drilldown by" option to split data by a given Field in a 

Dataset.  This option can limit the drill-down Fields available from a specific visual.  

o All Fields - Allows drilling down to all fields in the Dataset 

o Selected Fields - Choose which fields to drill down into (Example above allows only drilling 

down into Employees First Name, Employees Last Name and Customer) 
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Trend Charts 

To configure a Trend Chart, open the Report containing the chart and click the '...' icon in the top-right 

corner of the Visual. Select 'Configure' to open the Configure Visual window. To configure a Trend Chart that 

has been saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click on 

the Trend Chart. The left panel has four options with several settings users can use to customize their 

Visual: Series, Settings, Y-Axis, and Legend. 
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Series 

 

• Series Tabs - Lists the series that are part of the Visual  

• Add Dataset - Adds a new Dataset to the chart. Only Datasets that are associated with the Report 

can be added 

At the bottom of the Series panel are five icons - Series, Color, Labels, Drilldown, and Delete. Delete removes 

the current series from the chart, while the others show different settings for the series. 

Series 

• Series name - Changes the name of the series in the legend 

• Series chart type - Changes the type of chart being used 

• Select Dataset - Choose which Dataset that has the data needed 

• Date field - Select a date field to use for the x-axis of the chart 

• Value field - Sets the type of aggregate value to calculate for the series 

• Missing values - Choose how to handle dates with no values 

• Split by field - Choose which Field to split groups by if using a bar or column chart 

• Number of sub-groups to show - Choose added number of groups to show on chart 

• Stack split by - Changes how sub-groups are stacked if using a bar or column chart  

o None - No stacking, good for comparing values within a single group 
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o Normal - Stacks groups on top of each other, showing the total of split by groups separated 

by color 

o Percent - Shows what percentage each sub-group makes up of their corresponding groups 

• Regression equation - Allows users to choose an equation to use to fit the data to a regression line 

or curve 

• Y-Axis - Allows users to choose which y-axis to use for the series or add a new one. Y-axes can be 

customized in the Y-Axis panel 

Color 

• Series color - Allows users to change the color of the series 

Labels 

• Show labels in-line - Adds labels to the data points in the chart 

• Label content - Choose whether to show the group label, value, and/or percent of each group 

• Decimal Places - How many digits after the decimal to show 

• Tooltip - Changes how information is displayed when the user hovers the mouse over a group in the 

chart 

Drilldown 

• Enable view data - Enables the 'View data' and 'Pivot by' options to show a data grid or pivot table 

when the user clicks a group in the Visual 

• Enable chart drilldown - Enables the 'Drilldown by' option to split data by a given Field when the 

user clicks a group in the Visual 

https://informer5.zendesk.com/hc/en-us/articles/360001207626#243
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Settings 

 

• Interval - Choose what intervals to divide the date/time Field into 

• Zoom - Allows the user to zoom on the x-axis, y-axis, or both 

• X-Axis title - Supplies a label for the x-axis 

• Stack series together - Changes how series are stacked if multiple series are added and using a bar 

or column chart 

Y-Axis 

 

• Y-axes - Shows a list of y-axes that have been added. Click the down arrow to the left to change 

settings for individual axes 

• Add Axis - Adds a new y-axis to the Visual  

• Axis Title - Adds Title to Visual 

• Type - Choose which type of axis to use: Linear, Logarithmic, Datetime or Category 
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• Min/Max - Designates a min and max for an axis.  This helps to focus the view of the data on the 

Visual. (See Visual above is set to Min: 20 and Max: 100) 

• Show on Right Side - Not relevant as there would not be a second axis 

Legend 

 

• Show legend - Toggles whether to show a legend on the Visual 

• Float legend over chart - If enabled, places the legend on top of the chart instead of resizing the 

chart to make room for it 

• Vertical Align - Moves the legend to the top, middle, or bottom of the chart 

• Horizontal Align - Moves the legend to the left, center, or right side of the chart 

• Max height - Specifies the maximum height in pixels of the legend  

 

KPIs 

To configure a KPI (Gauge or Big Number), open the Report containing the Visual and click the "..." icon in 

the top-right corner of the Visual. Select "Configure" to open the Configure Visual window. To configure a KPI  

that has been saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click 

on the KPI. The left panel has two options to customize the Visual: Settings and Color. 
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Settings 

The options available in the Settings panel are dependent on whether the KPI being configured is a Big 

Number or a Gauge. 

Big Number 

 

• Aggregate value - Select which type of aggregate value to calculate data 



entrinsik.com/informer  Page 40 

• Decimal places - Select a Field to use for the y-axis of the chart 

• Font size - Sets the size of the font used to display the value 

• Approximate Value - Check box to round the value up to the next integer   

Gauge 

The Gauge displays the aggregate but allows for a range to be set.  This is a good visual to use when trying 

to display goals or levels to meet. 

 

• Aggregate value - Select which type of aggregate to calculate values  

• Decimal places - Select a Field to use for the y-axis of the chart  

• Show min/max values - Shows the minimum and maximum values on either side of the gauge  

• Minimum value - Sets the minimum value of the gauge.  Use a literal value or choose to use an 

aggregate value of an existing column. 

• Maximum value - Sets the maximum value of the gauge. Use a literal value or choose to use an 

aggregate value of an existing column. 

 

Color 

The color is set according to the percentage of the total value.  For the visual below, if the value of the 

aggregate is 50% of the total, the color will be closer to yellow.  In this example, the goal is 2 million, so the 

color is between yellow and green as it is more than 50%. 
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• Stop Colors - Choose colors for the gauge to gradually transition between and set the values where 

it will change from one to the next. Stop colors can be removed using the white '-' icon to the right of 

each color and added using the '+' icon below the list 

Maps 

Map Visuals can take any data from a result set associated with a location and overlay that data onto a map, 

broken down by country, state, or region. These maps are configurable depending on the specific location 

data in the result set There are two choices when creating maps in Informer, Map Visuals or Google Map 

Visuals. 
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Settings 

 

• Field - Select the Field with the names of the regions to group by  

• Y-Axis - Choose the aggregate for the value to view based on the groupings 

• Group - Choose how to group the data based on the type of map (ex. Countries, Continents, States 

and Provinces, etc.) 

• Map - Depending on which group, choose the Map  

• Map field - Choose the format of the regions in the selected Field (Ex. Name or country code).  This 

is dependent on the format of the values in the Field used in the map. 
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Color 

 

 

• Min color - Color used for the lowest values on the map 

• Max color - Color used for the highest values on the map  

Drilldown 

 

• Enable view data - Adds 'Pivot by' and 'View data' options when the user clicks a region on the map  

Google Maps 

In order for Google Maps to appear as an option, there is a setting in the Administration tab under Features 

to apply a Google API key. 
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• Location - Field containing the location of each record 

• Zoom - How far the map is zoomed in by default 

• Center Latitude and Longitude - Coordinates the map will be centered on by default 

• Show heat - Shows individual points for each record, with overlapping points changing from green 

to red depending on how many are overlapping 

• Show markers - Shows markers on the map indicating the number of data points in each location 

Additional Visual Types 

Line, Spline, and Area Charts  

To configure a Line, Spline, or Area Chart, open the Report containing the chart and click the '...' icon in the 

top-right corner of the Visual. Select 'Configure' to open the Configure Visual window. To configure a chart 

that has been saved to the Visuals of a Dataset, open the Dataset and click the Visuals icon and double click 

on the chart. The left panel has five options with several settings to use to customize Visuals: Settings, 

Series, Y-Axis, Legend, and Drilldown. 
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Settings 

 

• Group by - Select a Field to use for the x-axis of the chart 

• Sort groups by - Choose how groups are sorted along the x-axis 

• Number of groups to show - Maximum number of individual groups that should be shown in the 

chart 

• Include other/remaining items - Changes whether a separate group is generated for records not 

in the shown groups 
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• Include empty/null items - Changes whether groups with empty or null items are shown in the 

chart 

• Split by field - Choose which Field to split groups by if the user changes the chart to a bar or column 

chart  

• Number of sub-groups to show - Maximum number of sub-groups to split each group into 

• Zoom - Allows the user to zoom on the x-axis, y-axis, or both 

• Stacking - Changes how sub-groups are stacked if the user changes the chart to a bar or column 

chart  

o None - No stacking, good for comparing values within a single group 

o Normal - Stacks groups on top of each other, showing the total of split by groups separated 

by color 

o Percent - Shows what percentage each sub-group makes up of their corresponding groups 

• X-Axis title - Supplies a label for the x-axis 

Series 

 

• Series Tabs - Lists the series that are part of the Visual 

• Add aggregate - Adds a new series to the chart 

At the bottom of the Series panel are four icons - Series, Color, Label, and Delete. Delete removes the 

current series from the chart, while the others show different settings for the series. 
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Series 

• Value Type – Allows users to select which type of value to show with the series  

o Per-group - Calculates aggregate values for each group 

o Overall - Calculates aggregate values for the entire Dataset 

o Literal - Adds a horizontal line at a given value to the chart 

• Value - Sets the type of aggregate value to calculate for the series 

• Series name - Changes the name of the series in the legend 

• Series chart type - Changes the type of chart being used 

• Y-Axis - Allows users to choose which y-axis to use for the series or add a new one. Y-axes can be 

customized in the Y-Axis panel 

Color 

• Series color - Changes how the color of each series is chosen 

Labels 

• Show labels in-line - Adds labels to the data points in the chart 

• Label content - Choose whether to show the group label, value, and/or percent of each group 

• Decimal Places - How many digits after the decimal to show 

• Tooltip - Changes how information is displayed when the user hovers the mouse over a group in the 

chart 

Y-Axis 

 

• Y-axes - Shows a list of y-axes that have been added. Click the down arrow to the left to change 

settings for individual axes 

https://informer5.zendesk.com/hc/en-us/articles/360001207586#213
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• Add Axis - Adds a new y-axis to the Visual 

Legend 

 

• Show legend - Toggles whether to show a legend on the Visual 

• Float legend over chart - If enabled, places the legend on top of the chart instead of resizing the 

chart to make room for it 

• Vertical Align - Moves the legend to the top, middle, or bottom of the chart 

• Horizontal Align - Moves the legend to the left, center, or right side of the chart 

• Max height - Specifies the maximum height in pixels of the legend 

Drilldown 

 

• Enable view data - Enables the 'View data' and 'Pivot by' options to show a data grid or pivot table 

when the user clicks a group in the Visual 

• Enable chart drilldown - Enables the 'Drilldown by' option to split data by a given Field when the 

user clicks a group in the Visual 
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Reports 
Reports Overview 

What is a Report? 

A Report is considered the output view data in a formatted manner – whether it be a Data Grid table or a 

Comparison Dashboard for Executives. In essence, a Report is content created through assembling Visuals 

sourced from one or more Datasets, and is the result of the standard, but not necessarily required, 

Datasource(s) --> Dataset(s) > Report workflow. There are four standard types of Reports: Comparison 

Board, Dashboard, Data View, and Ad-hoc Query.  
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Creating a Report 

From the Report Listing page, click on the 'New Report' button. There are four types of Reports to choose 

from - Comparison Board, Dashboard, Data View, and Ad-hoc Query.  

 

 

 

After selecting a type of Report, enter a name and select the Dataset (Datasource for Ad-hoc Queries) and 

click 'Save' to create the report. 

Dashboards 

What is a Dashboard? 

A Dashboard is a collection of Visuals, sourced from one or more Datasets, on a canvas. 
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A Dashboard typically collects Visuals of a similar concern, such as Year over Year Product Sales, detailing 

associated metrics and performance against Key Performance Indicators. User can drag and drop the 

Visuals and resize them to highlight insights from the data. For example, display a large map of all the sales 

orders that shows strong markets and weak markets for potential growth, with supporting Visuals beneath. 

The design and layout of the Dashboard can be customized. 

 

Visual types – whether they are Saved Visuals attached to a Dataset or Visuals part of a Dashboard - control 

their own drill down strategy. A User does not have access to the Datasets used to create a Dashboard, 

except to the extent that a Visual drill down provides record level detail. 

 

Dashboards are also interactive in the sense that a User can filter the Visuals as a collective using the 

familiar Filtering UI. 
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Creating a Dashboard 

To create a Dashboard, go to the Report Listing Page and click 'New Report', then select 'Dashboard'. Enter a 

name for the Report and a Datasets to use (more can be added later), then click 'Save'. This allows options 

to customize the Dashboard. 

 

 

 

 

 

Dashboard Editor 

A Dashboard's layout can be edited by clicking "Layout Options". This allows for setting the minimums and 

maximums of the Dashboard's length and width as well as the margins and Slices. Larger screens allow for 

more "slices" of visuals allowing for more granular resizing. This menu also allows Users to decide whether 

or not the Visuals should have the footer visual on the Dashboard or if they should have distinct borders or 

be blended with the background. 

 

Visuals can be rearranged and resized in each of their panels. Visuals can be moved by clicking next to the 

title and dragging the Visual to the position on the screen. To resize a Visual, there is the option to drag to 

https://informer5.zendesk.com/hc/en-us/articles/360001193783
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resize the visual by hovering over the edge and clicking and dragging, either the sides for length and width 

or the bottom right corner for both. 

 

Note: After hiding the Visuals Options, configure Visuals by clicking the “Actions” menu in the top-right 

corner of the Visual and selecting “Configure”. 

The “Clear Visuals” layout option will remove all Visuals from the Dashboard. 

Adding Datasets 

Any Datasets added to the Dashboard can be used to build Visuals. The Datasets menu on the left lists all 

the Datasets that are part of a Dashboard. Click “+” to add a new Dataset to the Dashboard. 
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Click on any Dataset in this menu to see options available for changing the Dataset. A Dashboard can also 

be made from a Snapshot of a Dataset by clicking the camera icon after selecting the underlying Dataset. 

To refresh a Dataset from the Dashboard, click on “Refresh” on the three dots in the top-right corner. To 

apply filters to the Dataset, click on the + next to filter and choose existing saved filters or create a new one. 

 

Elements 

Use the "Add Elements" Menu to add new Visuals to the Dashboard or click the "+" next to Elements on the 

left menu. The options are "Discover", "Saved Visuals" and creating a new Visual. 

 

Inputs 

A special type of Visual is the Input. An Input can be a Date Range, a Distinct Value, a Number Range, or a 

Text Box. Once added to the Dashboard, Inputs allow Users to filter the data they wish to see based on the 

chosen Input. 

Panels 

A Panel is a special type of Visual that holds other Visuals. When creating a Panel, Users can name the Panel, 

show or hide a border, and show or hide a title bar. Panels act the same as other visuals with the same 

options to Configure, Rename, and Remove as all other visuals. 

 

Discover 

To create a Visual using the Discover feature, select "Discover" from the "Insert" menu. Check the boxes 

next to the Fields in the left panel of the Discover window to generate Visuals for the selected Fields. Once 
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one or more Fields are selected, click "Add Visual" in the bottom-right corner of the Visual to add it to the 

Comparison Board. Click the "X" in the top-right corner to go back to the Report. 

 

Saved Visuals 

To add a saved Visual from the Dataset, select "Saved visuals" from the Insert menu, choose the Dataset 

containing the Visual (if there is more than one Dataset), and then choose the Visual itself from the list on 

the left-hand side. A preview of the Visual will display in the right panel. Click "Add Visual" in the bottom-

right corner to add the Visual to the Comparison Board, then click the "X" in the top-right corner to close the 

window. 
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New Visual 

To create a new Visual for the Dashboard, open the "Insert" menu and select the type of Visual in the 

corresponding sub-menu. Choose the settings for the Visual, then click "Save" to add the Visual. 

Note: Visuals can utilize multiple series from more than one Dataset. See the "Adding and Managing 

Datasets" section above. 

 

 

Once a visual is added to a Dashboard, the Visual has a number of options available. 

The buttons at the top of each Visual are the same across all visuals. 

• Applied Inputs: Allows an Input filter to be applied to the visual. The available options are All Filters, 

No Filters, or Select Filters. 

• Move: Allows Users to snap panels to the Top of the Dashboard, the Bottom of the Dashboard, or to 

a Panel. 

• Actions: The actions menu allows Users to open the Configure panel to edit the Visual, Rename the 

Visual, or Remove the Visual from the Dashboard. This menu also tells the User when the data was 

last refreshed from the Dataset. 

The bottom buttons vary based on the visual except for the Filter button. See each Visual for the specific 

options available. The Filter button allows Users to filter each Visual individually. 
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Comparison Boards 

What is a Comparison Board? 

A Comparison Board allows for a quick easy comparative analysis of the data in a side-by-side Visual layout. 

It is a collection of Visuals, sourced from one or more Datasets, selected for the purpose of comparing 

segments of data against others or against the whole Dashboard. A Comparison Board typically collects 

Visuals of easily segmented data in a vertically organized, side-by-side display, such as Year over Year Sales 

by Salesperson, allowing users to split the data among axes. 
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Comparison Boards are split vertically at least once but potentially any number of times, once for each 

dimension. A Global Comparison, against which each split will filter, is provided at the very head of the 

board. Users can accept the default Comparison provided by the Report author or choose their own by 

clicking the Comparison header and choosing a field from one of the Datasets. Select a Filter for each split 

and see the Visuals automatically supply a comparison platform. The last dimension in order defaults to 

Everything Else. This represents all the records except what is currently filtered by other splits. Add a new 

split(s) for another comparison column. Visuals can only be stacked vertically within splits, and the Visual 

positioning applies to each split in the Comparison Board. Note that Comparison Board users do not have 

direct access to the Datasets driving a Comparison Board – users only access the resulting Visuals. 

Creating a Comparison Board 

To create a Comparison Board, go to the Report Listing Page and click 'New Report', then select 'Comparison 

Board'. Enter a name for the Report and select the Dataset to use (more can be added later), then click 

'Save'. This is the edit screen where users can customize their Comparison Board. 

 

 

https://informer5.zendesk.com/hc/en-us/articles/360001193783
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Adding Datasets 

The Dataset menu in the top-left corner provides a list of the Datasets used by the Report. To add a new 

Dataset, select the 'Add Dataset' option and choose the Dataset to add. Hovering the mouse over a Dataset 

displays options to change the Dataset as it relates to the Dashboard. 

 

 

• Saved Filters - Apply one of the Dataset's Saved Filters. 

• Custom filter - Create a new Filter to apply to the Dataset. 

• Benchmark - Test the performance of each step of running the query used by the Dataset. See 

Benchmarking. 

• Refresh - Update the data in the Dataset. 

• Remove - Remove the selected Dataset from the Report. Any Visuals using the Dataset will no 

longer work until the Dataset is re-added.   

Adding Visuals 

The Insert menu allows users to add new Visuals to the Comparison Board. This can be done in three ways: 

using Informer Discover, adding a Saved Visual, or creating a new Visual.  

Discover  

To create a Visual using the Discover feature, select 'Discover' in the Insert menu. Check the boxes next to 

the Fields in the left panel of the Discover window to generate Visuals for the selected Fields. Scroll through 

the list of fields to find ones to add, then click 'Add Visual' in the bottom-right corner of the Visual to add it 

to the Comparison Board. Click the 'X' in the top-right corner to go back to the Report. 

 

For more information about how to use Discover, see How to Use Discovery Mode. 

https://informer5.zendesk.com/hc/en-us/articles/360001179206
https://informer5.zendesk.com/hc/en-us/articles/360001163103
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Saved Visuals 

To add a Visual that has been saved to a Dataset's Saved Visuals, select Saved Visuals in the Insert menu. 

Select the Dataset that contains the saved Visual to add, then choose the correct Visual in the list to see the 

preview. Click 'Add Visual' in the bottom-right corner to add the Visual, then the 'X' in the top-right corner to 

close the window. 
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New Visual 

To create a new Visual for a Comparison Board, open the Insert menu and select the type of Visual needed 

to create in the corresponding sub-menu. Choose the settings for the Visual, then click 'Save' to add the 

Visual to the Comparison Board. 

 

For more information about how to configure different types of Visuals, see Visual Configurations. 

 

 

Layout 

The Layout menu allows users to change the layout of the Comparison Board. 

 

https://informer5.zendesk.com/hc/en-us/sections/360000227806
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• Hide Visual Options - Hide the various options available on each Visual. If Visual Options are 

already hidden, this will allow users to show them again. 

• Remove All Rows - Remove all Visuals from the Comparison Board.  

Select Comparison 

Select Comparison at the top of the screen to choose which Fields to compare the data by. After choosing a 

Field, click the Field name to edit or remove it or use the 'Start Over' button. 

 

 

Visual Options 

At the bottom of most Visuals, there are options that allow users to configure them, as well as a button to 

move the row it's into a new location. The options are dependent on the type of Visual. For a full list, see 

Visual Configurations. 

 

Note: If Visual Options are hidden, Visuals can still be configured by clicking the '...' icon in the top-right corner of 

the Visual and selecting 'Configure'. 

 

https://informer5.zendesk.com/hc/en-us/sections/360000227806
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Data Views 

What is a Data View? 

A Data View is a row and columnar grid sourced from a single Dataset. Data Views provide record level 

detail in a familiar spreadsheet type format allowing for on-the-fly groups, sorts, aggregates, formatting, and 

Pivot. 

 

 

 

A Data View consists of a set of columns and rows for standard display, and a Pivot Table for pivot style 

analytics. Within the default view, users can format columns to their liking and manipulate the grid by 
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column ordering, pinning columns so they are not affected by scroll, grouping, sporting, and 

hiding/unhiding columns. The Pivot view within a Data View Report supplies the same functionality as the 

stock Pivot Table Visual – use it to create crosstab summary data including aggregates and drill-down 

details. 

 

A Data View is a single Datasets driving a single row and column grid and a single Pivot Table. Note that Data 

View users do not have direct access to the Dataset driving a Data View – Users only access the resulting 

grid and Pivot Table. Users can provide optional static Filters for the Dataset and select the Fields for 

Column display. Each Column in the Data View provides formatting options based on the data type. 

Organize the Grid by supplying User Settings for a Data View.  The default structure is the one created by 

the author. Any pinning, grouping, etc. applied in Edit mode is saved as the base structure for the Data View. 

 

Creating a Data View 

To create a Data View, go to the Report Listing Page and click 'New Report', then select 'Data View'. Enter a 

name for the Report and select the Dataset to use, then click 'Save'. This will navigate to a screen to 

customize the Data View. 

 

 

https://informer5.zendesk.com/hc/en-us/articles/360001193783
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Adding Fields 

To add Fields to the Data View, check the boxes in the left panel next to the Fields to add, or click 'Select All' 

in the bottom-left corner to add all Fields in the Dataset. To remove a Field, uncheck the box next to the 

corresponding Field or click 'Clear' to remove all Fields. 

 

Fields are added to the Data View in the order they are selected, but users can click and drag a column 

header to move it to a new location. Fields can also be moved through the Field Settings menu by clicking 

the down arrow to the right of the header.  

 

 

Options 

Click the '...' icon in the top-right corner of the left panel to show the Data View options. 
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• Saved Filters - Apply one of the Dataset's Saved Filters. 

• Custom filter - Create a new Filter to apply to the Dataset. 

• Benchmark - Test the performance of each step of running the query used by the Dataset. See 

Benchmarking. 

• Refresh - Update the data in the Dataset. 

• Remove - Remove the Dataset from the Report. 

 

Discover 

What is Discover? 

With Informer Discover, Informer 5 does much of the thinking for the user and automatically suggests 

interesting Visuals based on the Fields and Filters that are selected! This enables the user to quickly analyze 

their data without any configuration of charts or graphs required.  

 

 

https://informer5.zendesk.com/hc/en-us/articles/360001179206
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How to Use Discover Mode 

To create a Visual using Discover Mode, go to the Dataset Listing page and open the Dataset needed. Click 

the wand icon in the left panel to open the Discover screen. 

 

 

 

To begin making Visuals, select the Fields to analyze in the right panel. The center panel will show several 

types of Visuals based on the type of fields picked. Visuals with multiple groups, such as charts and tables, 

will create groupings based on the order in which the Fields were selected. To remove Fields, uncheck the 

checkboxes next to the fields to remove, or click 'Start Over' next to the list of Fields above the Visuals to 

remove all Fields.  

Visual Options 

Each Visual that is generated using Discover can be customized using the icons at the top and bottom. 

 



entrinsik.com/informer  Page 68 

 

Expand 

The first icon in the top-right corner of the Visual is 'Expand'. This shows a larger view of the Visual.  

Options Menu 

The '...' icon in the top-right corner opens a menu with more Visual options: 

• Download - Saves a local copy of the Visual as an image or HTML file that can be used outside of 

Informer 5 

• Configure - Allows users to change the configuration of the Visual. For information about the 

configuration options of each kind of Visual, see Types of Visuals. 

• Pin copy to Homepage - Pins a copy of the Visual to the Homepage with the current configuration. 

Any changes made to the Visual afterwards will not affect the pinned version. 

• Rename - Renames the Visual 

• Revert - Reverts any changes made to the Visual's configuration since it was generated by Discover 

• Information – Indicates the last time the data being used in the Visual was updated  

 

Common Configuration Options 

Many Visuals have icons in the bottom-left corner that allow users to change common configuration 

options, such as groupings, more quickly than through the configuration screen.  

https://informer5.zendesk.com/hc/en-us/articles/360001172546
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Filter 

Filters data for a specific Visual. To learn how to filter Visuals, see Filtering a Visual.  

Save Visual 

Saves the Visual to Saved Visuals. 

 

https://informer5.zendesk.com/hc/en-us/articles/360001172566

